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PowerPoint Chapter 1

Creating and Editing a
Presentation



Objectives

• Start and quit PowerPoint

• Describe the PowerPoint window

• Select a document theme

• Create a title slide and text slides with single- and 
multi-level bulleted lists

• Save a presentation

• Copy elements from one slide to another

2Microsoft Office 2007: Introductory Concepts and Techniques - Windows Vista Edition



Objectives

• View a presentation in Slide Show view

• Open a presentation

• Display and print a presentation in grayscale

• Check spelling

• Use PowerPoint Help
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Plan Ahead

• Find the appropriate theme

• Choose words for each slide

• Format specific elements of the text

• Determine where to save the presentation
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Starting PowerPoint

• Click the Start button on the Windows Vista taskbar to 
display the Start menu

• Click All Programs at the bottom of the left pane on the 
Start menu to display the All Programs list

• Click Microsoft Office in the All Programs list to display 

• Click Microsoft Office PowerPoint 2007 to start 
PowerPoint and display a new blank document in the 
PowerPoint window

• If the PowerPoint window is not maximized, click the 
Maximize button next to the Close button on its title bar 
to maximize the window
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Starting PowerPoint

Microsoft Office 2007: Introductory Concepts and Techniques - Windows Vista Edition 6



Choosing a Document Theme

• Click Design on the Ribbon to display the Design 
tab

• Click the More button in the Themes gallery to 
expand the gallery, which shows more Built-In 
theme gallery options

• Click the Flow theme to apply this theme to Slide 
1
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Choosing a Document Theme
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Entering the Presentation Title

• Click the label, Click to add title, located inside 
the title text placeholder to select the 
placeholder

• Type A World Beneath the Waves in 
the title text placeholder. Do not press the ENTER 
key
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Entering the Presentation Title
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Entering the Presentation Subtitle 
Paragraph
• Click the label, Click to add subtitle, located 

inside the subtitle text placeholder to select the 
placeholder

• Type Spring Break in Cabo San 

Lucas, Mexico and then press the ENTER 
key

• Type Presented by Dave Ehlin, SGA 
President but do not press the ENTER key
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Entering the Presentation Subtitle 
Paragraph
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Selecting a Paragraph

• Triple-click the paragraph, Presented by Dave 
Ehlin, SGA President, in the subtitle text 
placeholder to select the paragraph
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Italicizing Text

• With the subtitle text still selected, click the Italic 
button on the Mini toolbar to italicize that text 
on the slide and on the slide thumbnail
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Selecting Multiple Paragraphs

• With the second subtitle text paragraph selected, 
press the CTRL key and then triple-click the first 
subtitle text paragraph, Spring Break in Cabo San 
Lucas, Mexico, to select both paragraphs
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Changing the Text Color

• With both paragraphs selected, click the Font 
Color arrow on the Mini toolbar to display the 
palette of Theme Colors and Standard Colors

• Click the Dark Blue button in the Standard Colors 
row on the Mini toolbar (row 1, column 9) to 
change the font color to dark blue

• Click outside the selected area to deselect the 
two paragraphs
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Changing the Text Color
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Selecting a Group of Words and 
Increasing Font Size
• Position the mouse pointer immediately to the 

left of the first character of the text to be 
selected (in this case, the C in Cabo)

• Drag the mouse pointer through the last 
character of the text to be selected (in this case, 
the s in Lucas)

• Click the Increase Font Size button on the Mini 
toolbar once to increase the font size of the 
selected text from 26 to 28 point
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Selecting a Group of Words and 
Increasing Font Size
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Bolding Text

• Click the Bold button on the Mini toolbar to bold 
the three selected words
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Decreasing the Title Slide Title Text 
Font Size
• Select the title slide title text, A World Beneath 

the Waves

• Click the Decrease Font Size button on the Mini 
toolbar twice to decrease the font size from 56 to 
48 point
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Decreasing the Title Slide Title Text 
Font Size
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Saving the Presentation

• With a USB flash drive connected to one of the computer’s USB 
ports, click the Save button on the Quick Access Toolbar to 
display the Save As dialog box

• If the Navigation pane is not displayed in the Save As dialog 
box, click the Browse Folders button to expand the dialog box

• If a Folders list is displayed below the Folders button, click the 
Folders button to remove the Folders list

• Type Cabo Package in the File name box to change the file 
name. Do not press the ENTER key after typing the file name

• If Computer is not displayed in the Favorite Links section, drag 
the top or bottom edge of the Save As dialog box until 
Computer is displayed
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Saving the Presentation

• Click Computer in the Favorite Links section to 
display a list of available drives

• If necessary, scroll until UDISK 2.0 (E:) appears in the 
list of available drives

• Double-click UDISK 2.0 (E:) in the Computer list to 
select the USB flash drive, Drive E in this case, as the 
new save location

• Click the Save button in the Save As dialog box to 
save the presentation on the USB flash drive with 
the file name, Cabo Package
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Saving the Presentation
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Adding a New Text Slide 
with a Bulleted List
• Click Home on the Ribbon to display the Home 

tab

• Click the New Slide button in the Slides group to 
insert a new slide with the Title and Content 
layout
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Adding a New Text Slide 
with a Bulleted List
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Entering a Slide Title

• Click the label, Click to add title, to select it and 
then type Package Highlights in the 
placeholder. Do not press the ENTER key
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Selecting a Text Placeholder

• Click the label, Click to add text, to select the text 
placeholder
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Typing a Single-Level Bulleted List

• Type Four nights at the Azure Seas 
Resort and then press the ENTER key to begin a 
new bulleted first-level paragraph

• Type Breakfast buffet, lunch, dinner, 
and snacks and then press the ENTER key

• Type Two large swimming pools and then 
press the ENTER key

• Type Round-trip airfare and hotel 
transfers and then press the ENTER key

• Type Daily activities, including 
water sports but do not press the ENTER key
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Typing a Single-Level Bulleted List
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Adding a New Slide 
and Entering a Slide Title
• Click the New Slide button in the Slides group on 

the Home tab to insert a new slide with the Title 
and Content layout

• Click the title text placeholder and then type 
Rates and Booking in this placeholder. Do 
not press the ENTER key
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Adding a New Slide 
and Entering a Slide Title
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Typing a Multi-Level Bulleted List

• Click the bulleted paragraph text placeholder
• Type Only $495 double occupancy and then press 

the ENTER key
• Click the Increase List Level button in the Paragraph group to 

indent the second paragraph below the first and create a 
second-level paragraph

• Type Non-diver rate: $275 and then press the ENTER 
key to add a new paragraph at the same level as the previous 
paragraph

• Type Single occupancy: add $150 and then press 
the ENTER key

• Click the Decrease List Level button in the Paragraph group so 
that the second-level paragraph becomes a first-level 
paragraph
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Typing a Multi-Level Bulleted List
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Typing the Remaining Text for Slide 3

• Type Nonrefundable $150 deposit 
required and then press the ENTER key

• Click the Increase List Level button in the Paragraph 
group to demote the paragraph

• Type Due by October 1 and then press the 
ENTER key

• Click the Decrease List Level button in the Paragraph 
group to promote the paragraph

• Type Travel insurance highly 
recommended but do not press the ENTER key
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Typing the Remaining Text for Slide 3
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Creating Slide 4

• Click the New Slide button in the Slides group

• Type Snorkeling and Diving in the title text 
placeholder

• Press CTRL+ENTER to move the insertion point to 
the text placeholder

• Type Three days of two-tank boat 
dives and then press the ENTER key

• Click the Increase List Level button. Type Weights 
and tanks included and then press the 
ENTER key

Microsoft Office 2007: Introductory Concepts and Techniques - Windows Vista Edition 38



Creating Slide 4
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Creating a Third-Level Paragraph

• Click the Increase List Level button so that the 
second-level paragraph becomes a third-level 
paragraph

• Type Instructors available for 
beginners and then press the ENTER key to 
create a second third-level paragraph

• Click the Decrease List Level button two times so 
that the insertion point appears at the first level
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Creating a Third-Level Paragraph
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Typing the Remaining Text for Slide 4

• Type Various locations based on 
diving skills and then press the ENTER key

• Press the TAB key to increase the indent to the 
second level

• Type Spectacular underwater wildlife 
and landscapes and then press the ENTER key

• Press the TAB key to increase the indent to the third 
level

• Type See squids, sea turtles, snakes, 
barracudas, and stingrays but do not 
press the ENTER key
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Typing the Remaining Text for Slide 4
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Duplicating a Slide

• Click the Slide 1 thumbnail in the Slides tab to 
display Slide 1

• Click the New Slide arrow in the Slides group on 
the Home tab to display the Flow layout gallery

• Click Duplicate Selected Slides in the Flow layout 
gallery to create a new Slide 2, which is a 
duplicate of Slide 1
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Duplicating a Slide
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Arranging a Slide

• With Slide 2 selected, drag the Slide 2 slide 
thumbnail in the Slides pane below the last slide 
thumbnail
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Deleting All Text in a Placeholder

• With Slide 5 selected, click the subtitle text 
placeholder to select it

• Click the subtitle text placeholder border to 
change the border from a dashed line to a solid 
line

• Click the Cut button in the Clipboard group on 
the Home tab to delete all the text in the subtitle 
text placeholder
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Deleting All Text in a Placeholder
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Changing Document Properties

• Click the Office Button to display the Office Button menu
• Point to Prepare on the Office Button menu to display the 

Prepare submenu
• Click Properties on the Prepare submenu to display the 

Document Information Panel
• Click the Author text box, if necessary, and then type your 

name as the Author property. If a name already is displayed in 
the Author text box, delete it before typing your name

• Click the Subject text box, if necessary delete any existing text, 
and then type your course number and section as the Subject 
property

• Click the Close the Document Information Panel button so that 
the Document Information Panel no longer is displayed
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Changing Document Properties
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Saving an Existing Presentation 
with the Same File Name
• Click the Save button on the Quick Access 

Toolbar to overwrite the previous Cabo Package 
file on the USB flash drive
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Using the Scroll Box on the Slide Pane 
to Move to Another Slide
• Position the mouse pointer on the scroll box

• Press and hold down the mouse button so that Slide: 
5 of 5 A World Beneath the Waves appears in the 
slide indicator

• Drag the scroll box up the vertical scroll bar until 
Slide: 1 of 5 A World Beneath the Waves appears in 
the slide indicator

• Release the mouse button so that Slide 1 appears in 
the Slide pane and the Slide 1 thumbnail has an 
orange border in the Slides tab

Microsoft Office 2007: Introductory Concepts and Techniques - Windows Vista Edition 52



Using the Scroll Box on the Slide Pane 
to Move to Another Slide
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Starting Slide Show View

• Point to the Slide Show button in the lower-right 
corner of the PowerPoint window on the status 
bar

• Click the Slide Show button to display the title 
slide
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Starting Slide Show View
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Moving Manually through Slides 
in a Slide Show
• Click each slide until Slide 5 (A World Beneath 

the Waves) is displayed

• Click Slide 5 so that the black slide appears with a 
message announcing the end of the slide show
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Displaying the Pop-Up Menu and Going 
to a Specific Slide
• With the black slide displaying in Slide Show 

view, right-click the slide to display the pop-up 
menu

• Point to Go to Slide on the pop-up menu, and 
then point to 2 Package Highlights in the Go to 
Slide submenu

• Click 2 Package Highlights to display Slide 2
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Displaying the Pop-Up Menu and Going 
to a Specific Slide
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Using the Pop-Up Menu 
to End a Slide Show
• Right-click Slide 2 and then point to End Show on 

the pop-up menu

• Click End Show to return to Slide 2 in the Slide 
pane in Normal view

• If the Microsoft Office PowerPoint dialog box 
appears, click the Yes button
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Using the Pop-Up Menu 
to End a Slide Show
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Quitting PowerPoint

• Point to the Close button on the right side of the 
PowerPoint title bar

• Click the Close button to quit PowerPoint
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Starting PowerPoint

• Click the Start button on the Windows taskbar to 
display the Start menu

• Point to All Programs on the Start menu to display 
the All Programs list and then point to Microsoft 
Office on the All Programs list to display the 
Microsoft Office list

• Click Microsoft Office PowerPoint 2007 on the 
Microsoft Office list to start PowerPoint and display 
a new blank presentation in the PowerPoint window

• If the PowerPoint window is not maximized, click the 
Maximize button on its title bar to maximize the 
window
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Opening a Presentation from PowerPoint

• With your USB flash drive connected to one of the computer’s USB 
ports, click the Office Button to display the Office Button menu

• Click Open on the Office Button menu to display the Open dialog 
box

• If the Folders list is displayed below the Folders button, click the 
Folders button to remove the Folders list

• If necessary, click Computer in the Favorite Links section and then 
scroll until UDISK 2.0 (E:) appears in the list of available drives

• Double-click UDISK 2.0 (E:) to select the USB flash drive, Drive E in 
this case, as the new open location

• Click Cabo Package to select the file name

• Click the Open button to open the selected file and display Slide 1 in 
the PowerPoint window
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Opening a Presentation from PowerPoint
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Checking Spelling

• Click Review on the Ribbon to display the Review tab

• Click the Spelling button in the Proofing group to start the 
spelling checker and display the Spelling dialog box

• Click the Ignore button to skip the word, Cabo

• Click the Ignore button to skip the word, Ehlin.

• When the Microsoft Office PowerPoint dialog box appears, 
click the OK button to close the spelling checker and 
return to the current slide, Slide 1, or to the slide where a 
possible misspelled word appeared

• Click the slide to remove the box from the word, Ehlin
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Checking Spelling
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Displaying a Presentation in Grayscale

• Click View on the Ribbon to display the View tab

• Click Grayscale in the Color/Grayscale group to 
display Slide 1 in grayscale in the Slide pane

• Click the Next Slide button four times to view all 
slides in the presentation in grayscale

• Click the Back To Color View button in the Close 
group to return to the previous tab and display 
Slide 5 with the default Flow color scheme
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Displaying a Presentation in Grayscale
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Printing a Presentation

• Click the Office Button to display the Office 
Button menu

• Point to Print on the Office Button menu to 
display the Print submenu

• Click Quick Print on the Print submenu to print 
the slides

• When the printer stops, retrieve the hard copy of 
the five Cabo Package slides
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Printing a Presentation
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Searching for PowerPoint Help

• Click the Microsoft Office PowerPoint Help button near the 
upper right-corner of the PowerPoint window to open the 
PowerPoint Help window

• Type document theme in the Type words to search for text 
box at the top of the PowerPoint Help window

• Press the ENTER key to display the search results
• Click the Maximize button on the PowerPoint Help window 

title bar to maximize the Help window
• Click the ‘Apply or customize a document theme’ link to display 

information regarding applying or customizing themes
• Click the Close button on the PowerPoint Help window title bar 

to close the PowerPoint Help window and display Slide 5
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Searching for PowerPoint Help
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Quitting PowerPoint

• Click the Close button on the right side of the 
title bar to quit PowerPoint

• If necessary, click the No button in the Microsoft 
Office PowerPoint dialog box so that any changes 
you have made are not saved
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Summary

• Start and quit PowerPoint

• Describe the PowerPoint window

• Select a document theme

• Create a title slide and text slides with single- and 
multi-level bulleted lists

• Save a presentation

• Copy elements from one slide to another
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Summary

• View a presentation in Slide Show view

• Open a presentation

• Display and print a presentation in grayscale

• Check spelling

• Use PowerPoint Help

75Microsoft Office 2007: Introductory Concepts and Techniques - Windows Vista Edition



Microsoft Office 2007

PowerPoint Chapter 1 Complete


